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Program Overview 
 

PowerPoint Poems  bring together poetry, design, and technology.  They offer students 
new ways to respond to poetry, to interact with it, and, best of all, to play with it.   
 
In this program, students select a favorite published poem or a poem of their own, and 
they present it, line by line, as a multi-media slide show.  They use images, colors, 
sounds, and creatively positioned and choreographed text to create their displays.  In 
doing this, they study a poem in depth, determine its meaning, and work towards 
conveying and enhancing that meaning with their design choices. 
 
 
Target Grade Level 
 
Grades 7 and 8, though it would be appropriate, with modifications, for students from 
grades 6-12.   
 
 
Major Goals 
 
This project assumes no familiarity with PowerPoint, and little familiarity with computers 
beyond basic word processing.  For students with more experience, the learning goals 
should be modified. 
 
Upon completing this project, students will be able to: 
 
• Use the design features of the PowerPoint program to create slide shows.  

Specifically, they will be able to perform the following tasks, which translate to other 
design and word processing software: 

• Draw shapes 
• Insert clip art and other images 
• Move and resize shapes and images 
• Change background colors and textures 
• Change fonts, font sizes, and colors 
• Send objects backward and forward 
• Use the animation tool 
• Use the slide transition tool 
• Set timings for the slide show 

 
• Discuss the meaning of their chosen poem, and explain how their design decisions 

relate to the poem's meaning (and sound/rhythm). 
 
• Constructively critique the design decisions of others. 
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Timeline: 
 
Six one-hour sessions in a computer lab.  These could happen once per week, as I have 
done, or more often.    
 
 
Types of Assessment Used 
 
• Peer Evaluation: Each student shares his or her project with the class periodically, 

and constructive critiques are given. 
 
• Self Evaluation: Students assess their own process and product at the end of the unit. 
 
• Teacher Evaluation: Students receive a grade on their projects, both for their 

process (use of computer lab time, and use of feedback) and for the final product. 
 
 
 
 
 
 

Lesson Plans 
 
The six lessons that follow are one hour each, and take place, ideally, in a computer lab. 
They are structured in the "writing workshop" format: 
 
 1. Mini-lesson introducing new skills 
 2. Work time 
 3.  Sharing 
 
Depending on the ability of your students, you may choose to introduce fewer skills per 
day, or more skills.  
 
The first lesson requires a lot of advance preparation, but much less is required in the 
lessons that follow, as students become more and more independent. 
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Lesson 1  (1 hour) 
 
Objectives: 
 
• To introduce the assignment 
• To teach basic PowerPoint skills, including how to: 

• Start a new slide show 
• Create a text object and choose fonts and font colors 
• Move and resize the text object 
• Format a "custom background" (choosing color, texture, pattern, etc) 
• Create a new slide 
• Present a slide show 

 
Advance Preparation:   
 

• Create a sample PowerPoint poem (or have a student example from a previous 
semester/year available). 

 
• Create a short slide show that introduces the project, with the words 

"Welcome to PowerPoint Poems" and "You are going to take a simple poem 
and make it sing, dance, run, and fly on a screen. You'll choose colors and 
pictures to work your poem. You'll show off the poem's best features, and 
you'll add new features that the poet never imagined.  Good luck." 

 
• Make copies of the poem used in the example (in its original print form) 
• Create a single sheet of suggested poems for this project.  They can be short 

and rhymed (as I often use), or related to the language arts curriculum. 
 
 
Materials required:   
 

• A computer (with Microsoft PowerPoint) for each student involved (or, you  
may choose to have the students work in pairs). 

 
• Copies of the example poem and the suggested poem sheet. 

 
The above are all you really need.  In an ideal world, you would also have the 
following: 
 
• Internet access for each computer, so students can search for clip art and 

sounds. 
 

• A demo computer for the teacher.  Ideally this would be equipped with a large 
television screen monitor, but if this is not available, you can make do (very 
easily with a small group) by having students gather around one computer. 
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• An area away from the computers where students can sit for discussions. My 
computer lab has a large meeting table in the middle. With a small-enough 
group, though, this is not necessary. 

 
Vocabulary: 
 

• enhance:  "How does this presentation enhance the meaning of the poem?" 
• text object:  A name for a block containing words, which can be moved  
                           around the screen. 

 
Procedure: 
 
1.  Introduce new assignment, "PowerPoint Poems."  Show brief teaser slide show on  
teacher's demo computer, or have students gather around one of the student's  computers. 
 
2.  Read example poem aloud (in my case it was "Dream Deferred" by Langston Hughes, 
is studied as part of our seventh grade curriculum).  Ask for student volunteers to define 
difficult words like "deferred" and "fester" from context. 

 
3.  Show demo PowerPoint poem twice.  On the second time through, ask students to 
look for ways that the presentation "helps" or "enhances" the poem, or makes the 
meaning of the poem clearer.  
 
4.  Discuss the ways the poem is enhanced by the presentation.  Comments for mine  
usually included:  

• The line 'And then run" actually runs;  
• "Maybe it sags like a heavy load" actually sags;  
• "Or does it explode" explodes;  
• The first slide is a different color than the others because it asks the question, 

and the others are possible answers; 
• "Or does it explode" is the exciting part, and it is the only part with sound in 

the presentation, to give it more emphasis. 
 
5.  Tell students that today they will do a "practice slide show" so they can learn the  
PowerPoint program, and, starting next session, they will begin work on their poems.  
Students then go to their computers and are shown where to find the PowerPoint 
program.  

 
6.  They start the program, and, when prompted, select "New Presentation."  From the 
array of templates, they choose the one with a single line of text (no graphs or bullet lists 
for this project!  Maybe explain to students the typical uses of this program at this point.)   
Students then type their full names into the text object. 
 
 
 
7.  Show students how to change fonts, font sizes and font colors (using toolbar buttons  
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and/or through Format menu).  Make sure students realize that they must "highlight" 
(make black) the letters for these changes to take effect. 
 
8.  Show students how to move the text object around the screen, and how to change its  
size. 
 
9.  Show students the variety of "Custom Backgrounds" available. (Select these from  
the Format menu).  Make sure students realize that they have to choose background 
colors that do not obscure their text (i.e., a black background and dark blue text doesn't 
work). 
 
10.  Now, have students click the "New Slide" button in the lower right hand corner, and  
reate a new slide using the same "single line of text" template that they used before.  
(Note: Steps 11-13 serve as a review). 
 
11.  On this new slide, they should type in a single piece of information about  
themselves, such as: "likes the color red";  "was born on December 5";  "likes  
chocolate ice cream" (or, inevitably, "loves the Backstreet Boyz") 
 
12.  Again, walk them through font, font size, and font color, and positioning the text on  
the screen.  
 
13.  Have them choose an appropriate background.  
 
14.  Have students save their slide shows. 
 
15.  Press the slide show button in the lower-left-hand corner and watch their slide shows.  
(They will have to manually advance the slides by clicking their mouse buttons) 
                                                                                                                                            
16.  Have the students share their results with their neighbors. 
 
17.  Give homework assignment: Give students a sheet with some suggested poems.   
Tell them to read these, and consider using one of them.  They may also bring their own 
favorite poem, or a poem that they have written, for next session.  Remind students of 
this assignment at least once before the next session. 
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Lesson 2 (1 hour) 
 
Objectives: 
 
• To teach more PowerPoint skills, including how to: 

• Open an existing presentation 
• Use the "slide sorter" view to look at the entire presentation 
• Animate text 
• Adjust direction of animation 
• Adjust sounds associated with animation 

• Plan PowerPoint poems using a planning sheet. 
 
Advance Preparation: 
 

• Make additional copies of the suggested poems in case kids have lost them. 
• Copy presentation planning sheet. 

 
Materials required: 
 

• Computer lab as previously described 
• PowerPoint presentation planning sheet 
• Suggested poem sheet 

 
Vocabulary: 
 

• animate: To "bring to life" (to make text or objects move) 
 
Procedure: 
 
1.  Students go immediately to their computers and start PowerPoint.  They then open  
their presentations from last session. 
 
2.  Students are now in the "Slide Sorter" view.  Show students how to navigate between  
views using the buttons in the lower-left-hand corner. 
 
3.  Returning to slide sorter view, they double-click on their second slide. 
 
4.  They click on the animation star button to reveal the animation toolbar. 
 
5.  They click on the text, then choose an animation effect. 
 
6.  They then press the "slide show" button in the lower left corner. 
 
7.  They watch their newly animated slide show. 
 
8.  Returning to the second slide, they choose other animation effects. 
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9.  Once they have arrived at the effect they like, they are shown how to adjust the  
direction of the animation.  (The directions/timing/sounds button on the animation tool 
bar). 
 
10.  Once they have chosen their direction, they are shown how to adjust sounds. 
 
11.  Students save and share presentations with their neighbors.  (Or, if there is time, you 
may choose to have a full-class sharing session). 
 
12.  Students take out "suggested poems" sheet and come to center table (or remain at 
their computers, depending on lab set up).  Going around the table, we read aloud the 
poems the students have selected. 
 
13. Students are given presentation planning sheets.  They are shown the teacher's  
planning sheet for the example ("Dream Deferred") presentation.  They spend the rest of 
the period planning their presentations.  They are told the requirements for their first slide 
(poem title and author) and last slide ("presented by").  If there is time, some may start on 
the computers. 
 
Homework assignment: Complete planning sheets. 
 
 
Lesson 3 (1 hour) 
 
Objectives: 
 
• To begin designing PowerPoint poems. 
• To review PowerPoint skills learned in lessons 1 and 2, and to add the following 

skills: 
• How to create a new text object/text box 
• How to add a graphic 
• How to draw a shape 

 
Advance Preparation: None 
 
Materials Required: Just the lab, maybe some spare planning and suggested poem 
sheets.   
 
Procedure: 
 
1.  Students start PowerPoint, and begin a new presentation. 
 
2.  Everyone begins the first slide by choosing the template with the single line of text,  
filling in the poem's title, and adjusting fonts and backgrounds. 
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3.  To add the author's name, they are shown how to create a new text object, by clicking 
and dragging the mouse to form a box, then typing the poet's name.  They adjust font 
colors, sizes, etc. 
 
4.  Show students how to add a graphic by choosing a clip art file (from the "Insert"  
menu) 
 
5.  Show students how to draw shapes, using the "Drawing" Tool Bar.  (Show them how  
to display the Drawing Tool Bar by using the "View" menu). 
 
6.  Students then have the rest of the period to create slides.  The teacher moves around,  
offering assistance and feedback. 
 
7.  At the end of the session, the teacher asks for volunteers to share.  Teacher models  
how to give constructive feedback, then asks students for comments. 
 
 
Lesson 4 (1 hour): 
 
Objectives: 
 
• To continue designing poems 
• To review PowerPoint skills learned in lessons 1-3, and to add the following: 

• How to create transitions between slides. 
 
1.  Students start PowerPoint and open their presentations. 
 
2.  They each choose their second slides, then, from the "Tools" menu, they choose  
"Slide Transition" 
 
3.  They each choose a transition effect. 
 
4.  Selecting their first slide, they press the slide show button in the lower left corner and  
watch their slide show with the new transitions. 
 
5.  Students then have the rest of the period to work on their presentations.  The teacher  
moves around, offering assistance and feedback. 
 
6.  At the end of the session, the teacher asks for volunteers to share.  Teacher models 
how to give constructive feedback, then asks students for comments. 
 
7.  Students are told that they have only another half of a period to complete their 
projects. If they need more time, they are to come in during lunch or after school. 

 
Homework: Work on project, if needed. 
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Lesson 5 (1 hour): 
 
Objectives: 
 
• To finish designing poems 
• To constructively critique peers' projects 
 
Advance Preparation: 
 
• Make copies of peer response sheet 
 
Materials Required: 
 
• Peer response sheet 
 
Vocabulary: 
 
• Constructive Feedback:  Comments that are positive, intended to help the designer 
make improvements, not insult the work or hurt feelings. 

 
Procedure: 
 
1.  Students immediately get to work.  They have 30 minutes to complete their 
presentations. 
 
2.  Convene group; show students the feedback form.  Give example of how to fill it out,  
using one student's project. 
 
3.  Students are given partners; they switch computers and fill out forms. 
 
4.  Students then meet with partners and share feedback.  At the end of class, tell students  
they will have 15 minutes at the start of the next class to make any last minute changes. 
 
Homework Assignment: Come in after school or during lunch to make changes, if  
more time is desired.  
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Lesson 6 (1 hour): 
 
Objectives: 
 
• To make any last-minute revisions 
• To set slide timings 
• To share and celebrate the completed projects 
 
Advance Preparation:   
 

• Make copies of self-evaluation form 
 
Materials Required:   
 

• Self-evaluation form 
 
Procedure: 
 
1.  Students immediately get to work.  They have 15 minutes to complete their 
presentations.  Those who are finished can spend their time creating or embellishing their 
final slide, the "presented by" slide. 
 
2.  After this, students move to the slide sorter view.  They click the stopwatch "Set Slide  
Timings" button, and move through their slide shows at the rate they want it to go. 
 
3.  They then choose "Slide Show" from the "View" menu and choose "Use slide 
timings" 
 
4.  The whole class then takes turns sharing and offering positive feedback.  Celebrate! 
You may choose to do this in full writing workshop style, with food, drink, invitations... 
 
Homework Assignment: Students fill out self-evaluation form. 
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Evaluation/Assessment: 
 
Students are graded on both their process and their product.  See forms in the next 
section.   
 
The student's self-evaluation is a narrative form. This is to help the teacher decide if the 
student was designing thoughtfully and purposefully to "enhance" the poem's message (or 
some may use the design to "contrast" also).  
 
Teachers may also want to give students an exact copy of the score form and have them 
score themselves.  
 
 
 
 
Follow-up Activities: 
 
1.  If possible, at the end of the last session, or during another session, students from  
other classes can be invited into the lab to have a look at the slide shows. 
 
2.  Students can be allowed to use PowerPoint to present their next research project. 
 
3.  Students can use PowerPoint to publish their own poems in Writing Workshop. 
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Sample Worksheets 
and 

Evaluation Materials 
 
 
The following pages include: 
 
1) Suggested poems 
2) Presentation planning sheet 
3) Peer response sheet 
4) Self-evaluation sheet 
5) Final evaluation sheet 



  

 
Suggested Poems 

 
 
Animal Poems by Ogden Nash: 
 
The Hippopotamus 
 
Behold the hippopotamus 
We laugh at how he looks to us 
And yet in moments dank and grim 
I wonder how we look to him. 
Peace, peace, thou hippopotamus! 
We really look all right to us, 
As you no doubt delight the eye 
Of other hippopotami. 
 
 
The Panther 
 
The panther is like a leopard, 
Except it hasn't been peppered. 
Should you behold a panther crouch, 
Prepare to say Ouch. 
Better yet, if called by a panther, 
Don't anther. 
 
 
The Rhinoceros 
 
The rhino is a homely beast, 
For human eyes he's not a feast. 
Farewell, farewell, you old rhinoceros, 
I'll stare at something less prepoceros. 
 
 
The Lion 
 
Oh, weep for Mr. and Mrs. Bryan! 
He was eaten by a lion; 
Following which, the lion's lioness 
Up and swallowed Bryan's Bryanness. 
 
 
 
 

 
 
 
 
 
 
By Gwendolyn Brooks: 
 
We Real Cool 
 
The Pool Players. 
Seven at the Golden Shovel. 
 
We real cool. We 
Left school.  We 
 
Lurk late.  We 
Strike straight.  We 
 
Sing sin.  We 
Thin gin.  We 
 
Jazz June. We 
Die Soon. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



  

 
 
By Langston Hughes: 
(1902-1967) 
 
Island  (1959) 
 
Wave of sorrow, 
Do not drown me now; 
 
I see the island 
Still ahead somehow. 
 
I see the island 
And its sands are fair: 
 
Wave of sorrow, 
Take me there. 
 
 
 
Dream Deferred 
 
What happens to a dream deferred? 
 
Does it dry up  
like a raisin in the sun? 
Or fester like a sore-- 
And then run? 
Does it stink like rotten meat? 
Or crust and sugar over-- 
like a syrupy sweet? 
 
Maybe it just sags  
like a heavy load. 
 
Or does it explode? 
 
 
 
 

 
 

 
 

 

 
 
 
By Stephen Crane: 
(1871-1900) 
 
The Heart   (1895) 
 
In the desert 
I saw a creature, naked, bestial, 
Who, squatting upon the ground, 
Held his heart in his hands, 
And ate of it. 
 
I said, "Is it good, friend?" 
"It is bitter -- bitter," he answered; 
"But I like it 
Because it is bitter, 
And because it is my heart." 
 
 
 
 
 
 
Choose one of these-- or bring 
in a copy of your own favorite 
published poem, or a poem 
that you have written.   
 
 
 
 



  

Presentation Planning Sheet   Name ____________________________________ 
 
 
 
 

 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



  

Peer Response Sheet  Name _____________________ 
 

 
Name of Designer ___________________________ 
 
 
1.  What do you like about this presentation?  List specific  
aspects that you like. 
 
 
 
 
 
 
 
 
 
2.  In what ways does the presentation "enhance" the poem? 
 
 
 
 
 
 
 
 
 
3.  What could the designer add to this presentation to make it  
better? 
 
 
 
 
 
 
4.  What could the designer remove from the presentation to 
make it better? 
 
 
 



  

Self-Evaluation Sheet  Name _____________________ 
 
 
1.  How does your presentation enhance the poem?  Explain  
some of your design decisions and how they relate to the  
poem's meaning, or its sound and rhythm. 
 
 
 
 
 
 
 
 
 
 
2.  List some ways that you used feedback from your  
peers and the teacher.  Give specific examples! 
 
 
 
 
 
 
 
 
3.  Did you have any trouble meeting deadlines?  Why? 
 
 
 
 
 
 
 
4.  What are your presentation's strengths? 
 
 
 
 
 



  

PowerPoint Poem Evaluation  
 
Name ___________________________________ 
 
 
Process: 
 
 Use of computer lab time      /10 
           (Did you stay focused on the task?)  
 
 
 Use of feedback       /10 
 (Does the presentation incorporate feedback?) 
 
 
 Homework assignments complete    /10 
 
 
 Project completed on time      /10 
 
      Total    /40 
 
Product: 
 
 First and last slides meet requirements    /10 
 
 Design makes it easy to read text     /10 
 (Text is not too small or hidden by colors or graphics)  

 
 

 Slide show is paced appropriately     /10 
 (Timings are not too quick or too slow) 

 
 

 Design "enhances" poem in creative ways   /30 
 
 
 
      Total    /40 
 
 
Bonus:  Student added own graphic     + 
or sound files, or scanned in own pictures...        
 
      TOTAL   /100
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Resources 
 

I.  Software 
 
A.  One copy of Microsoft Office (which includes PowerPoint) costs roughly $400 for an 
individual computer.  To outfit an entire lab, see if your school or school district has (or 
can get) the appropriate license.  
 
B.  If students want to show their friends and parents their displays, but don't have 
PowerPoint at home, they can download a free PowerPoint Viewer  from Microsoft at 
the following URL: 
 

http://officeupdate.microsoft.com/2000/downloadDetails/Ppview97.htm 
 
C.  Another software option, for those who do not have PowerPoint:  
 

ClarisWorks Poems : Many schools in New York City have ClarisWorks (on 
Project Smart computers). This software has a slideshow option. You can even 
use it to create your own animations, frame by frame. This may be a good 
alternative for schools without the MS Office bundle. 

 
 
II. On-line 
 
A.  Free clip art and sounds 
 

Chances are, your kids will have graphic and sound needs beyond the MS Office 
gallery. To accommodate these, if your computers have Internet access (or even if 
just one of them does), show the kids how to search for clip art and sounds on-
line.  Good spots: 

 
1.  The Microsoft gallery is regularly updated, and includes all sorts of sounds,  

             from "throaty quacks" to "a long cow moo".... 
 

http://cgl.microsoft.com/clipgallerylive/default.asp?nEULA=1&nInterface=0 
 
2.   For a menu of many clip art galleries: 
 
      www.clipart.com 
 

Or, search AskJeeves (www.ask.com) for "clip art" 
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3.  Other good clip art galleries: 
 

www.Clip-art.com 
www.barrysclipart.com 
www.free-clip-art.net 

 
4.  I show this to kids as part of another project, but you may want to add to this  

            project a lesson on copying images from the internet, using the right mouse        
            button. 
 
B.  PowerPoint tutorial 
 
There are a couple of free PowerPoint tutorials on-line.  The following is from a course 
given at the University of Rhode Island (using PowerPoint for Mac). It may be of use if 
you don't already know PowerPoint. 
 
http://einstein.cs.uri.edu/tutorials/csc101/powerpoint/ppt.html 
 
 
C. Collecting Suggested Poems 
 
I love "Ask.com."  Search under "poems" or for your poet of choice there (or on any 
search engine).  Here are some results, for Countee Cullen, Robert Frost and Emily 
Dickinson: 
 
http://www.nku.edu/~diesmanj/cullen.html 
http://www.library.utoronto.ca/utel/rp/authors/dickn.html 
http://www.library.utoronto.ca/utel/rp/authors/frost.html 
 
Note: two of the above sites are from the University of Toronto's "Representative Poetry 
On-line" which contains 2,200 English poems by over 340 poets. It is searchable by poet 
& poem, and it contains other interesting resources, like a timeline of poets and a 
glossary of poetic terms. It can be found at: 
 
http://www.library.utoronto.ca/utel/rp/intro.html 
 
 
 
III. Books 
 
A.  For PowerPoint  (there are many, including some on CD.  Search Amazon.com) 
 
     PowerPoint for Dummies (for '97 or 2000) by Doug Lowe 
    Microsoft® PowerPoint® 2000 Bible by Faithe Wempen, Don Roche 
   10 Minute Guide to Powerpoint 97 by Faithe Wempen 
Advantage Series: Microsoft PowerPoint 2000 by Sarah E. Hutchinson 
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B.  Poems 
 
I like short, rhyming poems for this project. Ogden Nash is one of my favorites. Here is a 
good edition of his works: 

 
Selected Poetry of Ogden Nash: 650 Rhymes, Verses, Lyrics and Poems.   

New York: Black Dog & Leventhal, 1995. 
 
You may also choose to use short forms like limericks or haiku.  A good haiku  
collection is: 
 
 Haiku, This Other World  by Richard Wright.  New York: Little, Brown, 1988. 
 
I also like some of the poems in this anthology: 
 
 An Introduction to Poetry by X.J. Kennedy.  New York, Harper Collins, 1990. 
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Examples of Student Work 
 
 

I chose the following examples because they exemplify the variety of results. They are all 
the work of 8th graders. 
 
A.   This is Lauren's project.  She chose to use her own poem, as was a common choice  
among the eighth graders. The seventh graders stuck to the poems I provided, with only 
one exception (and that was someone who brought in a favorite published poem).  Most 
of the eighth graders' poems were identity declarations like this one. 
 
B.  Quintin chose to use the Langston Hughes poem on the "Suggested Poems" sheet.  He  
used lots of graphics and animation, and he divided up the lines in interesting ways.  It is 
important to stress to students that they can spread a single line across several screens if 
they feel emphasis is needed on certain words. 
 
C.  Ronald and Jeremiah also chose one of my "Suggested Poems." The beauty of this  
project is, unfortunately, lost on paper. They used the animation to bring in words with a 
rhythm that perfectly matched the poem. 
 
D.  Glenny used "We Real Cool."  Her use of graphics was outstanding. 
 
E.   This is the example I used as a model at the start of the project.  
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Appendix 
 

For those who do not know PowerPoint, you may find that these screenshots are useful 
visuals as you read through the lesson plans. 

 
They correspond to lessons 1, 2, and 4. 

 
 


